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1. What can I do if my products are funded by European projects (H2020, FP7, FP9) whose
calls for proposals mandate open access publishing?
In the Horizon 2020 funding programme, the European Commission introduced the obligation
to archive the publisher's version (PDF) or the author's peer-reviewed version, not yet
formatted by the publisher (post-print), in an institutional or disciplinary repository (arXiv,
PubMed, BioRxiv) within 6 months of publication.
Please note that failure to fulfil any of the obligations set forth in the Grant Agreement,
including open access dissemination of the research outputs, can result in a reduction of
the initial funding.
Please note that starting with the next H2020 framework programme, the European
Commission will no longer reimburse APCs on hybrid journals (traditional journals), thereby
favouring publications on fully open access journals.
(DOAJ stands for Directory of Open Access Journals)
Pre-prints constitute Open Access publications (see the OpenAIRE blog)
2. Which research product versions can be archived in the Institutional Repository?
•

The publisher's version: if the article has been published under Creative Commons
license such as CC-BY (Attribution) or CC BY-SA (Attribution-ShareAlike)
Compare a list of publishers that accept archiving of the publisher's version
Refer to the funders' Open Access conditions on SHERPA/JULIET

•

The post-print version, i.e. the accepted peer-reviewed manuscript without any
layout done by the publisher (example of post-print)
Please note that most journals generally allow this version to be made open access
12 months after publication, which is in conflict with the Open Access requirements
of the European Commission. Therefore, you should:
-

choose a publisher that allows open access publishing 6 months after
publication. Refer to the policies on self-archiving of foreign publishers on
SHERPA/RoMEO;

-

or attach an addendum to the publication agreement to reuse your work within 6
months of publication.
Should the publisher not be willing to reduce the embargo period, the project
coordinator shall inform the project officer and send all relevant documentation
to: RTD-OPEN-ACCESS@ec.europa.eu

3. Elsevier imposes rather long embargo periods (i.e. delayed access): how can I meet H2020
requirements?
Elsevier applies specific embargo periods to its journals: Journal-Specific Embargo Periods
Therefore, it is possible to meet the H2020 Open Access requirements as follows:
IMMEDIATE ACCESS: by archiving the pre-print (unreferenced version) in arXiv or RePEc, which are
disciplinary repositories. The pre-print will later be updated with the “Accepted Manuscript”, also
known as post-print (author's peer-reviewed version, without publisher's layout).
Please note that the “Accepted Manuscript” shall include:
- link to the publication with the DOI code
- a CC-BY-NC-ND license – see how to do this
You can read Elsevier's Open Access policy by clicking on the following link

4. Is open access required also for products financed by ministerial funds (PRIN, SIR, etc.)?
Article 4 of the Italian law on Open Access - Law no.112 of 7 October 2013 - claims that publiclyfunded products shall be made open access as follows:
a) through publication by the publisher, at the time of the first publication;
b) through archiving in institutional repositories within 18 months of publication for scientific,
technical and medical papers, and within 24 months for papers in the field of humanities
and social sciences.
MIUR Directorial Decree no.197 of 23 January 2014
SIR (Scientific Independence of Young Researchers) call for proposals
Article 9. Open access
1. Each PI shall ensure open access (free on-line access for all users) to any peer-reviewed scientific
publication concerning the results achieved throughout the project. In particular, the PI shall:
a) As soon as possible, and at the latest at the time of publication of the research outputs, archive a
machine-processable electronic copy of either the published version or the final (peer-reviewed)
version accepted for publication in a repository for scientific publications. The PI shall also undertake
to archive any data needed to validate the results presented in the scientific publications deposited;
b) Ensure open access to the archived publication and any related data - through the repository at the latest at the time of publication, if the publisher offers a free electronic version, or within six
months of publication (twelve months for publications in the field of humanities and social sciences);

c) Ensure open access - through the repository - to bibliographic metadata identifying the
deposited publication.

5. Research data: when and how is open access mandatory?
The European Commission, in its capacity as funder of H2020, provided directives (as from 2012)
that mandate open access not only to scientific publications but also to research data (specifically
for 9 fields of application), as well as the possibility for projects in other disciplinary areas to
participate on a voluntary basis.
The data that led to those publications shall be open, both technically, that is in non-proprietary
format, and legally, meaning that it has to be associated with usage rights.
The document “Guidelines on FAIR Data Management in Horizon2020” contains the latest
guidelines

What is research data?
The term “Open Research Data” refers to the data underpinning scientific research results that has
no restrictions on its access, enabling anyone to access it through the Internet.
Why should it be openly accessible?
Aside from the social (progress and cooperation), economic and administrative (transparency)
benefits, there are requirements set by the European Commission whereby grants are contingent
upon open access, as specified in Article 29.3 of the Grant Agreement.
Should all data be openly accessible?
Not all data can be open.
Naturally, the European Commission gives beneficiaries the possibility to opt-out at any stage of
the project (both before and after the signing of the Grant Agreement), provided that the following
conditions are met:
● The project does not generate nor gather data
● The data needs to be protected for possible economic exploitation
● Incompatibility with data protection for security reasons
● Incompatibility with the requirements on the protection of sensitive data
● Making data openly accessible might jeopardise the project's main objective

● Other legitimate reasons that have to be described and justified
It is also possible to make only one data subset open.

What characteristics should data have?
According to the EC, data shall comply with the FAIR principle and be:
•
•
•
•

Findable: data can be searched using unique identifiers and descriptive metadata
Accessible: data shall be archived in such a way as to be easily reusable
Interoperable: data has to be shared through standard protocols (OAI-PMH)
Reusable: data has to be presented in a non-proprietary format and, from a legal viewpoint, it
has to be released with a usage license such as the CC0 (Public Domain) or CC-BY Creative
Commons licenses

What procedure should I follow?

1) Drafting a DMP (Data Management Plan)
A Data Management Plan describes the data management and conservation activities according to
the specifics of the research discipline within 6 months of the project’s approval. The researcher
shall also explain how the FAIR principles are implemented:
A Data Management Plan should:
include an administrative section concerning the research project, stating: name of the project,
project manager, funder and affiliation;
state the names of data creator and data manager;
describe the data (what data will be collected and in which format) and state the purpose of data
collection;
specify how data will be made findable. This means also providing descriptive metadata;
specify which data is made openly accessible, stating the methods and software tools used to do
so (if applicable, the software source code), and which data is kept closed and why (ethical, legal, or
contractual reasons);
explain how the data will be licensed to permit text and data mining. There is always the possibility
to set an embargo period, which means delaying open access. This applies to patents or subsequent
publications based on said data;
specify the repository for data archiving and long-term preservation (if applicable, specify the costs
incurred).
The DMP should be updated over the course of the project.

A tool for DMP creation (DMPonline), provided by the Digital Curation Centre, is available at the
following link (http://www.dcc.ac.uk/resources/data-management-plans).

2) Archiving data in an appropriate repository
•

A disciplinary repository already in use within the reference community:
the Registry of Research Data Repositories (https://www.re3data.org/) of the Karlsruher
Institute of Technology is an Open Science tool helping researchers find the appropriate
repository for their data, where it is possible to choose CC0 and CC-BY licenses

•

Zenodo (https://zenodo.org/): a multidisciplinary repository hosted at CERN, Geneva
(Zenodo also assigns a DOI to the dataset)

3) You should also include the link to the repository where you have archived your data
(URL, DOI, handle) in Iris SISSA Digital Library, in the dedicated “Research data” field, so as
to link the publication to the data from which it was generated.
This field is only mandatory for products financed with public funds.

6. What is the ORCID code?
The Open Researcher and Contributor ID (ORCID), whose adoption has been promoted at national
level by ANVUR through the I.R.ID.E. (Italian Research IDentifier for Evaluation) project, is a unique
identifier that associates each researcher to their scientific publications.
To synchronise the LoginMIUR profile with the IRIS profile of SISSA Digital Library, it is necessary
to create (if the author does not have an identifier) or associate (if the author already has an
identifier) an ORCID ID. This operation shall only be performed once.
Once you log in to IRIS, you will see a registration window related to the ORCID ID. To start the
procedure, click on “Create or Associate your ORCID Id”. Now you can:
 create a new identifier (for users without ORCID) using the “Create new ORCID” button.
In this case, you have to fill in a form entering the requested information, set a
password and click on the

button

 associate an existing identifier using the “Associate your ORCID” button
You will just have to enter your ORCID credentials and click on the

button

In the next steps you will be asked the authorisations to associate your ORCID ID with the local
(IRIS) and national (LoginMIUR) systems. To complete the synchronisation procedure, just leave
the check mark in the permits box, then click the

button

At the end, the system will direct you to IRIS which will give a feedback on the process and return
a message with the generated ID.
To find out more, click here
7. How are products organised in my Products Desktop?
When you log in, you will be directed to the main page, which is named “Products Desktop”

Layout customization

Fig. 1

Action menu

Fig. 1

The tabs displayed in your personal view are the following:
•
•
•

My submissions: shows all the research products whose data you are responsible for or of
which you are an identified author
Items to be validated: shows all the research products identified by the system which could
belong to you and on which you can perform a self-identification procedure
Identification to be approved: shows the products whose data you are responsible for and
on which the co-authors have performed a self-identification procedure, which you have to
validate or reject
To confirm the data, click on the Validate identification button.

View customisation
Show / hide columns

You can add further data to display in your Desktop (e.g. “Year”)
You can also order it chronologically with the arrows at the top

Fig. 2

You can save these changes (both column ordering and product filters) using the
button. From the drop-down menu, click on “Save view” and in the window that will be displayed,
name your view. You can also make this your default view.

Fig. 3
To upload previously saved views or go back to the basic view, select the corresponding option
from the drop-down list.

Fig. 4

Status of submission to the ministerial website

Fig. 5

The
column shows the status of the publication submission to the ministerial website.
The status can be one of the following:
•

•

The product has been regularly sent to the ministerial web pages of all its
identified authors
The publication has not yet been sent

•

The publication has been rejected by the LoginMIUR website; clicking on this
button, you will see the cause of the error

•

The publication is in DRAFT status. Only DEFINITIVE products can be transferred
to the LoginMIUR website

•

The synchronisation with the LoginMIUR website is not active for a

given publication

Possible actions

The
button under the
publication:

column allows you to perform some actions on a specific

Fig. 6

8. How can I manage my “Profile”?

Alternative names

Fig. 7

If, for their publications, a professor also uses a name other than that saved in their personal data,
it is necessary to create alternative names.
Go to “Personal Data” > “Alternative names”, then click on + (Add entry) to create alternative
names.

Fig. 8

The MAIN alternative name is the one preferred for citations or for other uses within the
system.
The alternative name has to be entered in the description field, in the following format: Last
name, First name

Fig. 9

External IDs tab
Enter you Scopus or ORCID IDs in the “External IDs” tab, then click “SAVE”.

Fig. 10

9. How can I submit a product by direct import using an ID (Scopus code, DOI code, PubMed
code, ISBN, etc.)?
We recommend you import your product using the Search by identifier function as this reduces
the margin of error when editing the metadata and facilitates data migration to LoginMIUR.
Step 1: Log in to SISSA Digital Library with your SISSA credentials

Fig. 11

Step 2: Access the repository in 1. “Personal view”, then 2. Open the menu (identified by a grid in
the top bar)

2

1

Fig. 12

Step 3: A side bar is displayed where you can select 1. Products > MyDSpace, then 2. Click on New
Item

2
1

Fig. 13
1. Search by “identifier”: 2. Enter your DOI, Scopus, or Pubmed code…, then 3. “Search”

1

2

10.5860/lrts.40n3.267

Fig. 14

Fig. 14

3

Once you have found your publication, you have to import the metadata and select the
publication type:

1

2
3

Fig. 15
Fill in the various forms: Describe, Upload (file upload), Verify, License, Complete

1 – Describe:

Fig. 16

2 – Describe:
Using the Submission by Identifier feature, many bibliographic data will automatically populate
the record.
We recommend you verify or enter (if not yet present), the following bibliographic data:
Title
Year of publication
Year of publication online
Language
Journal, Series

Title of the product

Web of Science code
Volume number, issue, pages
DOI code
PubMed ID
Scopus code
URL

Useful for assessment. Where do I find it?

Research data
Referee
Abstract
Keywords
Other information
Relevance
Funding program
Project identifier

In IRIS, journals are hosted at ANCE, the
ministerial database managed by CINECA
If you use the Enter manually feature, click HERE

Useful for assessment. Where do I find it?
Repeatable field. You can add links to external
repositories where a version of the products is
archived (e.g. ArXiv, PubMed)
Repeatable field. You can add a link to the
repository where the research data is archived

National/International. See criteria
To be filled if your project is funded by a FP7 –
H2020 programme
Fig. 17

Required
Required
Recommended
Recommended
Required

Required
Recommended
Required
Recommended
Required
Recommended
Required for
H2020
Recommended
Recommended
Recommended
Optional
Recommended
Required

Fig. 18

You can also import your product by using the Import from bibliographic files option and
uploading the file (previously exported from the reference database) in one of the following
formats: arXiv (xml), BibTex, Csv, Cini (xml), Crossref (xml), Endnote, Isi, Pubmed (xml), Ris, Tsv.

1
2
3

Fig. 19

10. What is ANCE?
ANCE is a ministerial database managed by Cineca where national journals and series are indexed.
In IRIS, to enter the details of the journal in which an article is published, or those of the series a
monograph is part of, the user has to click on the ANCE button and search for the relevant journal
or series.
The search can be performed by title, ISSN or ANCE code.
If the title of the journal is not present, the author can request it be included in the ANCE catalogue
with the option “Enter manually”. In this case, the self-archiving of the new product will stay in
“draft” mode until Cineca recognises the journal and sends the corresponding code.

Fig. 20

BACK

11. Where do I find the IDs of my scientific product in the Scopus and Web of Science databases?
Scopus
To find the identification code of your publication
http://www.scopus.com/home.url and search for your article.
Once you have found your contribution, pay attention to the URL:

in

Scopus,

log

in

to

Fig. 21
The identification code is found within the URL, between ?eid= and &origin= as shown
below:
https://www.scopus.com/record/display.uri?eid=2-s2.0-0030508174&origin=resultslist&

BACK

Web of Science
To find the identification code of your publication in Web of Science, log in to
http://apps.webofknowledge.com/ and search for your contribution. Click on the title and scroll
the information on the page down to:
See more data fields > Document Information. In this section you can find the Accession number,
i.e. the ISI identification code, identified by the acronym WOS which makes it easily recognisable:
000…………..

Fig. 22

BACK

What are the criteria to assign international relevance to a research product?
International relevance is generally assigned to a research product that meets at least one of the
following verifiable indicators:
-

the product is the result of an explicit cooperation with researchers and research groups
working with institutions from foreign countries (e.g. within international projects);

-

that product has been, or can also be disseminated within the scientific community in other
countries;

-

the publication has been submitted to an international scientific committee or the board
and/or editorial team includes foreign scholars.

BACK

12. How do I edit the author name string?
3 – Describe:
Within the Authors box, the authors' names are generally separated by a semicolon (;)
e.g.: Rossi, Maria; Bianchi, Fabio; Verdi, Mario
1) The system will automatically display a summary table with the names of the authors. The
authors' names will be highlighted in the following colours:
Green
Orange
Light grey

If recognised as SISSA authors
If you have to disambiguate the recognition: in this case, you just
have to click on the name and select the right option
In the case of external authors

2) Once you have entered the string in the form, clicking on “Run author name string” will
start the authors' recognition process.

Fig. 23

Filters
Once the processing of the authors string is complete, the results are displayed in a table. Above
the table is a form that allows you to filter the results.

Fig. 24

Below is an explanation of each filter:
•

Search: a free-text search form that allows you to search for an author by typing their
name or part of it

Fig. 25

Filter also the author name string: an option that also allows you to display the results within the
same author name string. For example, by typing “ros” in the author name string, only “M. Rossi”
will be displayed

Fig. 26
•
•
•
•

Items per page: the maximum number of results per page to be displayed on the table
below
Show all authors: all the authors found within the author name string, regardless of their
position
Show SISSA authors: only SISSA authors recognised in the author name string
Show external authors: only authors external to SISSA, recognised in the authors string

The results found by the authors recognition algorithm are shown in a tabular form. The
meaning of each column is explained below:
•
•
•

•
•

•

Position: the author's position within the author name string
Author: author's name
Position & Area: the area the author belongs to. If populated in the Profile tab, the
following data will be shown: Qualification, Area, SSD, Competition sector, Matriculation
number, Faculty, Email
Attributes: it is possible to specify that the author is a Corresponding Author, i.e. the SISSA
author who interfaces with the publisher
Type: indicates the type of contribution the author gave to the product according to the
CRedit taxonomy. To find out more on the CRediT taxonomy, go
to http://docs.casrai.org/CRediT. The detail of each role is available at the following page:
CASRAI Roles
Disclaim: if enabled, it allows an author to disclaim a publication

13. How do I upload files?
4. Upload
Now you can upload all your files. More specifically, the following types:
File type
Publisher's PDF

Access policy
Immediate Open
Access

Publisher's PDF

Yes, but with
Embargo
(transition period
between
publication and
full accessibility)
Closed Access

Publisher's PDF
Post-print
(author's peerreviewed version
without
publisher's layout)
Post-print
(author's peerreviewed version
without
publisher's layout)
Pre-print
(unreferenced
author's draft)

Immediate Open
Access

Open Access, but
with Embargo

Open Access

-

Terms
If allowed for by the publisher
Generally, usage licenses (CC-BY) are applied
Refer to the self-archiving policies of foreign publishers on
SHERPA/RoMEO
Refer to the self-archiving policies of foreign publishers on
SHERPA/RoMEO

The publisher only authorises it for internal access or
temporarily for evaluation purposes
- Refer to the self-archiving policies of foreign publishers on
SHERPA/RoMEO

Most publishers allow OA with a 6, 12, 18, 24-month
embargo
- Refer to the self-archiving policies of foreign publishers on
SHERPA/RoMEO
Refer to Elsevier's Journal-Specific Embargo Periods
If the publisher allows for archiving in the institutional
repository

In order to comply with Art.4 of SISSA's Regulation on Open Access: “The SISSA shall endeavour
to render all products archived in the SISSA Digital Library in open access format, consistent with
the provisions of copyright law, contracts entered into with publishers and funding bodies”,
start the archiving process of a “Post-print” version, or in the case of a “Pre-print”, with its
“Corrigenda”.

File uploading in IRIS
a) Select your file and upload it

Fig. 27
After you have chosen your file, a red trash can icon appears in case you have attached the wrong
file and need to delete it.

b) Select the file type from the drop-down menu:

Fig. 28

c) Access policy
Shows who can display and download the file once it is viewable on the public portal.
The suggested values are as follows:

- Open Access
- Embargo
- Archive admin only

Visible to everyone
Visible to anyone after a given period
Closed access

Fig. 29

If you choose “Embargo” as Access Policy, you have to go to the window below, which is also
named “Embargo”: a calendar will be displayed for you to choose the date on which you want
your product to become visible.

Fig. 30

c) Select the license type from the drop-down menu. The options are as follows:
- Not specified
- Public domain: Please note that this is a permissive license with which the author waives their
exclusive rights
- Creative Commons

Fig. 31

d) LoginMIUR website transfer
Select Yes/No from the drop-down menu

e) File description
This is a free-text field where you can add notes on the uploaded file.
NB: LoginMIUR only accepts full-texts in PDF format up to 10MB

Step 5: Verification – This is the second last form that allows you to check the metadata and
correct it if necessary.

Step 6: Grant Validation
After the self-archiving procedure, the product metadata and files will be submitted to the
librarians for validation.

14. Even though I have self-identified as co-author, my name does not appear among the coauthors. Why?
Following a self-identification request, the person responsible for the data has to validate the
identification by going to the Identification to be approved tab. To expedite the process, you can
contact the person responsible for the data, requesting them to perform said action.

NB: If the person responsible for the data does not validate the identification, the author's name
will not be added to the tab and the information will not be transferred to the LoginMIUR
website

15. How can I recognise the workflow status of my product?
The status of a product registration on IRIS can be as follows:

In validation: when the author completed the submission,
but the registration is yet to be verified and approved by the
Library
Re-opened: when, following validation, the author accesses
the tab using the Re-open button
Definitive or Validated: the registration has been validated
by the Library
Draft: when the author responsible for the data has not yet
completed the submission

Fig. 32

You can make changes to your record by using the “Re-open” button at any time, even after
validation is complete.

Fig. 33

16 When are the products sent to the LoginMIUR website?

The transfer is performed daily by incremental batch, which means that only modified products are
synchronised. Metadata is synchronised first, followed by full-texts.
A new synchronisation of products in “Warning” status is attempted every week.
By default, the product's authors (personal view), administrators (full view) and the person
responsible for the data can force the synchronisation.
NB: Only products that are not in “Draft” status (Definitive, In validation, Validated) are
transferred to LoginMIUR
The MIUR column of the Products Desktop displays the status of the registration compared to the
submission of the publication to the LoginMIUR website.

17 How can I create the bibliography of my products from IRIS SISSA Digital Library?
You can export your bibliography by using the Export button on your Products Desktop. Different
export formats are available.
IRIS allows you to export the list of your publications in citation format. By integrating the use of
IRIS with two of the most popular tools - Zotero and Mendeley - you can choose your preferred
citation style. The first is a free tool and the latter is the free version of the commercial product
Elsevier.
This guide assumes that these tools are already installed on your PC. For further details on
installation,
go
to
the
following
download
pages:
https://www.zotero.org/download/
https://www.mendeley.com/downloads
Through the “Export”feature, available both within the Products Desktop and in the search results
section of the IRIS SISSA Digital Library, you can generate a bibliographic file with the list of
publications
for
which
you
want
to
create
a
citation
format.
For example, to get a list of your publications, you have to access IRIS in “Personal view”, then go
to Products > Products Desktop. Once you have obtained your list, click on the Export button, then
choose your preferred format. In this guide the BibTeX format will be used.

Fig. 34

If, instead of your products, you want a citation-style list of a group of products, you can use the
Advanced Search form.
Just click on Advanced Search. Using the filters (e.g. time range), you can generate the desired
product list, and if you click Search, then Export, you get the bibliographic file of your products.

Fig. 35

Generating a citation file with Zotero
Open Zotero, then go to File > Import and choose the IRIS-generated file.

Fig. 36
This action will make the products exported from IRIS available.

Fig. 37

Now, you have to choose the products you want, then click on the right mouse botton and select
“Create Bibliography from Item”.

Fig. 38
In the next form, select your preferred citation style then click OK to generate an RTF file
containing the desired bibliography.
Choosing the bibliography format
If you want to change the format of your bibliography, go to Edit > Preferences, then to the Export
tab. Now you can change format by choosing a new one from the Default Format drop-down
menu.

Fig. 39

To find out more on the use of Zotero, go to
https://www.zotero.org/support/

Generating a citation file with Mendeley
Open Mendeley Desktop, then go to File > Import and choose the IRIS-generated file.

Fig. 40

This action will make the products exported from IRIS available.

Fig. 41
Now, select the products you want, then click on the right mouse button and select Copy As >
Formatted Citation.

Fig. 42

Now you just have to open a text editor and paste the generated bibliographic citation.
To find out more on the use of this tool, go to
https://www.mendeley.com/guides?dgcid=Mendeley_Desktop_Help-Online-guides

For any queries, please contact:

sdl@sissa.it

Visit also the “FAQ” page of our Library

